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1 Introduction

Welcome to PrintShop Mail Web, the easy-to-use, powerful, and open web-to-print system. PrintShop Mail
Web is a Web-to-Print solution that allows print providers and brand owners to effectively manage promotional
print flows, streamline customer interaction, and combines the benefits of Variable Information (VI) with On-
Demand Printing.

PrintShop Mail

PrintShop Mail allows to prepare and add template documents to PrintShop Mail Web. Template documents
are used as the basis for print jobs, meaning that it is possible to reuse the templates by uploading new
databases.

This guide provides information how to publish templates from PrintShop Mail. If you are new to PrintShop
Mail you can check the PrintShop Mail site at www.objectiflune.com. On that site are several guides than can
help you get started.
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2 PrintShop Mail user interface

Here a global overview of the PrintShop Mail graphical user interface (GUI).

• Tools toolbar: This toolbar allows you to insert (variable) text and images, rotate items and insert PDF
files.

• Layout toolbar: This toolbar allows you to skip to the different layouts.
• Database toolbar: This toolbar allows you to browse the records and gives a preview of the variables

used in PrintShop Mail.
• Layout window: Gives a preview of the current layout.
• Properties panel: The Properties Panel is the part of the PrintShop Mail screen that shows the

properties of the currently selected item.
• Different toolbars: Here you can change i.e the font, borders around text, paragraph settings, borders

around text- and image boxes and many more features.
• Menu: The menu, where you can select different options.

The PrintShop Mail user interface

Objectif Lune Inc. © 2010 2



3 Publication settings

When publishing documents to PrintShop Web, it is important to check the following:

• Windows Printer Settings
• PrintShop Mail Publication Settings
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3.1 Windows Printer Settings

To print documents correctly it is important that the printer set in the PrintShop Mail document matches the
printers available on the PrintShop Mail Web server. Check the following:

• Printer name
• Verify the PPD version

3.1.1 Printer name

The printer name should match. PrintShop Mail Web verifies if the printer specified in the document is
available on the web server. If the printer is not available, the default printer will be used for that document.
You won’t get a warning when you publish the document and you should check the printer name in PrintShop
Mail Web after publishing the document.

On the PrintShop Mail Web server you can add, delete and modify printers in the Printers and Faxes window of
the Microsoft Windows operating system. This window can be accessed via the Start menu.

3.1.2 Verify the PPD version

PostScript printer description (PPD) files describe the fonts, paper sizes, resolution capabilities, and other
features that are standard for your PostScript printer. PPD files are used by PostScript printer drivers to
determine how to print your document. If you do not use the correct PPD file, your document might not print
correctly, or not all of the printer’s features will be available when you print.

Use the same PPD (PostScript Printer Description) on both your PrintShop Mail client machine and PrintShop
Mail Web server. Contact your System Administrator which PPD to use.
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3.2 PrintShop Mail Publication Settings

In order to publish documents to the PrintShop Mail Web server it is required to adjust the settings in
PrintShop Mail. To change these settings open the Preferences dialog of the PrintShop Mail (Edit menu). Select
the PrintShop Mail Web pane on the left side of the Preferences dialog. Change the settings for the URL, Login
and Password. Contact the Administrator of the PrintShop Mail Web server for the correct settings.

To test your settings click the Test Connection button.

The PrintShop Mail Web settings pane in PrintShop Mail
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4 Business Cards

A business card is one of the cost-effective marketing tools a business can have. With PrintShop Mail you can
create business cards in a minute, print them or publish them to PrintShop Mail Web. Publishing to PrintShop
Mail Web is a great advantage. Clients can fill in their names and order business cards anytime, anywhere. In
this section you will learn how to:

• Create a business card with variables
• Enable repetition on a page
• Upload the business card to PrintShop Mail Web
• How to change the data in PrintShop Mail Web

A business card example
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4.1 The Business Card document

Start the PrintShop Mail application. Open the job Business Card.psmd in the Business Card folder. The
business card document consists of one layout with crop marks. The document contains various variables and
the background image is a PDF file.

The business card document
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4.2 Variable Text

Text objects in PrintShop Mail can contain both static and variable text. Variables are surrounded by the @
character. Click in the Variable Pane of the Properties window to view the variables for this document.

Variables and Data Fields

When creating variables in PrintShop Mail, the variables will be shown in the Variables pane. To let customers
input data in PrintShop Mail Web a Data Field should be created.

The business card variables

Data Fields are representatives for the variable data that can be provided either directly through a database
that you link to a PrintShop Mail document, or through any other data source, for example a database which is
uploaded by a PrintShop Mail Web client or a web form. For more information on Variables and Data Fields
please refer to the PrintShop Mail manual.
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4.3 Expressions

To create a Data Field an expression so should be created for one or multiple variables. Each variable in the
business card document has an expression and a result. By double clicking a variable the expression builder
will appear.

The expression builder

Enter the name of the variable or a custom value and place this between square brackets. The expression
automatically creates a Data Field.
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4.4 Data Field properties

Select the Data Fields pane. By selecting a Data Field, you can view and edit its properties in the Properties
panel. The Data Field properties let you change the following items:

• Default Value: this value will be initial value that the end user will be see in PrintShop Web
• Remarks: the information in this field will add a comment to the PrintShop Mail Web user input form.

You can use this to give clients a hint about the information that need to be entered for this field.
• Source: this option can be either Database, a database uploaded by the PrintShop Web client, or User

Input, manually entered data using a web form.

The Source options

In the Business Card document we used User Input for the data fields. In the PrintShop Mail Web web site the
client should enter data by typing it in a web form.
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4.5 Crop marks and Repetition settings

PrintShop Mail has the ability to print crop marks and print multiple layouts (in this case business cards) on a
paper. These settings can be found in the PrintShop Mail preferences.

Repetition settings in PrintShop Mail

Crop marks

To print crop marks around a layout, select Imposition in the Preferences dialog (Edit menu)

Repetition

The settings in the Repetition panel allows you to print multiple layouts on a page. The values between the
brackets by Horizontal and Vertical are the maximum of repetition for this layout on page.

In this case we used the paper format A4. If you change the paper size in the Page Setup (File menu) to for
example A3 the maximum number of repetition will also change. Before you print or upload the job you may
verify the document, which reduces errors. You can find this option in Layout menu (Verify Document).
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4.6 Print the job

You may want to verify the output before publishing the document to PrintShop Web. Select Print in the File
menu to output the document to a printer.
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4.7 Publish to PrintShop Web

Upload the job to PrintShop Web. Before continuing be sure that you have read the instructions in the chapter
How to Publish templates from PrintShop Mail in the PrintShop Mail manual.

A business card example

Select Publish to Web in the File menu and follow the instructions on-screen. In the Publish to Web dialog
create a new publication type and click Next. Follow the instructionson-screen to publish the document.
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4.8 The online document

After publishing the template document your customers can start creating jobs using the PrintShop Mail Web
web site.

Open a browser, for instance Internet Explorer and enter the URL of your PrintShop Mail Web web site. Login,
navigate to the New Document section and select the Business Card document. The user input form appears
showing three input fields. Change the values of these fields and click Preview to update the thumbnail and
view your changes.

Click Next to complete the ordering process.

The business card user input form showing the data fields
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5 Postcards

A travel agent wants to inform existing customers that they offer short vacations. They decide to send each
customer a personalized postcard, based on their vacation interest last year. The interests of the customers
are divided in:

• a family vacation
• a cultural vacation
• an active vacation

A business card example

The interest of the customers are stored in a database. That database is going to be used to personalize the
cards, with text and an appropriate image. In this section you will learn how to:

• Print pages based on someone’s interest
• Enable repetition on a page
• Upload a variable data job to PrintShop Mail Web server
• How to handle it in PrintShop Mail Web
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5.1 Ingredients

Creating a variable document is like cooking. To create an excellent meal you need the right ingredients and
proper equipment. Without it, the outcome is unpredictable. First we will explain which ingredients are needed
for creating this variable data example:

• a database with customers names, addresses, interests etc.
• a PDF file which holds all the layouts for the postcards

The travel agency wants to send the customers a postcard based on their interest. In this case the vacation
interests are:

• Family: receives the family postcard
• Active: receives the sailing postcard
• Cultural: receives the music postcard

The database

First have a look at the database. The field names (in red) are Name, Surname, Address, City, Zip code and
Interest. Here are 3 examples, based on customer interest (light blue):

• John’s interest is Cultural and he will receive the music postcard.
• Mike and Joanne will receive the family postcard
• Nick will receive the sailing postcard, based on his active interest

Page 4 of the PDF is going to be used for the addressing and is printed on the reverse side of each card. With
PrintShop Mail you do not need to split up the database or the PDF to print this job in one run.

Objectif Lune Inc. © 2010 16



5.2 Layouts

To continue you need to start PrintShop Mail. Locate the Postcards folder and open the Postcards.psmd
document. This document contains 4 layouts using a PDF background image. Scroll through the layouts to
view the different designs:

• layout 1: contains the Family image
• layout 2: contains the Sailing image
• layout 3: contains the Music image
• layout 4: contains the Reverse side image

Before we continue lets have a closer look at the database and after that what expression is used to print and
skip certain layouts.

The postcard database

The value of the Interest database field defines the layout to be printed. This is handled through an
expression. The following table shows per record if the layout will be printed or skipped.

The above shows us that Record 1 will print Layout 3 and Layout 4. Layout 4 will be printed on the reverse
side and is required for all records (this is a duplex document).
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5.3 Layout conditions

To print layouts, based on the customers interest, we use a Layout Condition. Layout Condition can skip, print
or leave pages blank during the printing process. In this case we have to tell each layout, based on the
customer interest, if it should be printed or not (skipped).

A postcard sample

Select Layout 1 in the Layout pane on the right hand side of the PrintShop Mail window. The layout shows the
Family image. We want to print this layout if a customer is interested in a family vacation. The Action item in
the Properties pane tells you if the current layout is going to be printed or not.

The Action option in the Properties pane

Scroll through the records using the browse options at the bottom of the screen and you will notice that each
layout has its own condition.
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Setting up a condition

To change the layout condition select the layout in the Layouts pane and click the Action value in the
Properties pane. This will open the Expression builder showing the expression for the selected layout.

The layout condition in the expression builder

Below an overview of the layout conditions used in the postcard document.

Layout 1:
IF(CONTAINS([Interest], “Family”), Print, Skip)

The explanation for this expression is, if the database field Interest contains the text Family, it will print. If it
does not contain the text Active it will not print and skip the layout.

Layout 2:
IF(CONTAINS([Interest], “Active”), Print, Skip)

If the database field Interest contains the text Active, it will print. If it does not contain the text Active it will
not print.

Postcards - Layout conditions
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Layout 3:
IF(CONTAINS([Interest], “Cultural”), Print, Skip)

If the database field Interest contains the text Cultural, it will print. If it does not contain the text Cultural it
will not print.

Layout 4:
Print

This layout will print all the records. It will print on the reverse side, as the document will be printed duplex.

Postcards - Layout conditions
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5.4 Repetition on page

PrintShop Mail can print multiple layouts on a paper that has a larger format than the size of a layout. The
layout in this job has the size of the PDF and depending on the paper source of the printer driver you can
determine how many times it should repeat on a page.

The amount of repetition can be selected in the Repetition pane of the Preferences window (Edit menu).

Repetition settings

Changing the paper size, will also change the maximum amount of repetitions. You can change the paper size
in the Page Setup window (File menu).
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5.5 Printing the document

You may want to verify the output before publishing the document to PrintShop Mail Web. Select Print in the
File menu to output the document to a printer. Make sure your printer supports duplex printing.

Postcard output
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5.6 Publish the document

Before continuing be sure that you follow the instructions in the chapter How to Publish to PrintShop Mail Web
in the PrintShop Mail manual. From PrintShop Mail select Publish to PrintShop Mail Web in the File menu and
follow the online instruction. Publish the job to the Marketing publication type.

Select the Marketing publication type
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5.7 PrintShop Mail Web

Open a browser, for instance Internet Explorer and enter the URL of your PrintShop Mail Web web site. Login,
navigate to the New Document section and select the Postcard document.

In this case the document requires you to upload a database file. Click Browse and select the Postcard.xls
database file. After uploading the file you can browse the records and update the preview.

Click Next to complete the ordering process.

The postcard document in PrintShop Mail Web
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6 Newsletters

A travel agency sends out a newsletter to their existing customers. The newsletter contains variable images
based on the customer vacation preferences. The newsletter also offers a customer a 5% discount if they
register on the Travel Agency website.

This letter contains multiple variable elements like:

• variable customers (from a database)
• automatic date
• variable images based on a customer interest
• variable travel agent

The newsletter sample
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In the next pages you will learn how to:

• Create an automatic date
• Create variable images based on someone’s interest
• To upload this to PrintShop Mail Web server

This newsletter is a combination of variable data from a database and input fields. It has also variable images
based on a customer holiday interest.

Newsletters - PrintShop Mail Web
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6.1 Variable elements

Start PrintShop Mail and open the Newsletter.psmd file located in the Newsletter folder (Examples folder).

The newsletter layout

The document contains variable text elements (bold font style) and a variable image. Select the text box to
get an overview of the variable text elements.

The variable text elements
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These variables also appear in the Properties panel (select Variables option). In this chapter we will explain
how to create a:

• Variable date
• Create input fields, which can be altered in PrintShop Mail Web
• Variable images

The Variables pane showing the variables for the Newsletter document

Newsletters - Variable elements
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6.2 Variable date

Double click on the variable Date in the Variables pane, the expression builder will be opened. The expression
builder shows the Today function. This function will return the current date, based on the system time. For
example if today is 27 August 2006 it will return that date on screen.

Click OK to leave the expression builder.

The Today functions returns the current date

The Properties pane shows the formatting for the Date variable. To change this format click the date format, a
popup menu appears showing the various date format options.

The Today functions returns the current date
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6.3 Input Fields

In the Newsletter document we created two user input fields:

• the Name Travel Agentvariable
• the Position Agent variable

Double clicking the variable Name Travel Agent will open the expression builder. Between the brackets you
will see the variable: [Name Agent]

This variable does not come from a database, but was typed in. Click OK to close the expression builder
window.

Select Data Fields in the Properties window, and you can change it properties. By clicking the variable Name
Agent, you have the possibility to alter the source of it. In this case we choose the option User Input. User
Input fields gives end users the possibility to type in data or change its default in the PrintShop Webweb site.

Change the Source option to User Input in the Properties pane

Objectif Lune Inc. © 2010 30



6.4 Variable images

The Newsletter document contains a variable image. Based on the customers interest a specific photo is
printed. This document makes use of four different images:

• Paris
• Barcelona
• Amsterdam
• Sydney

As stated the images are printed by the holiday preferences of a customer. When a customer visited Paris, a
picture of Paris will be printed. When he visited Sydney, a picture of Sydney is printed. The information comes
from the database field Location. Scroll through the records and you will notice that the variable image will
change.

Connecting variable images to the database information can be done in a few easy steps. We have created an
image box using the Image box tool. This will automatically create a variable called Image 1 (Variables pane).
Double click this variable to open the expression builder. Below you can see how the data of Location field is
used to define the name of the image.

Change the Source option to User Input in the Properties pane

Once you have setup the expression you will need to define the location of the images. Select the image box
in the layout and click the Image folder option in the Properties pane. Browse for the folder containing the
images and click OK.
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Note: If you are using images that are based upon conditions, and these conditions determine that
the image should not be displayed (empty file name as result), a notification will be included in
the preflight data for each empty image. The notification displayed is this No image specified. In
order to avoid this you may want to use a transparent image as alternative for the empty file
name.

The Image folder option in the Properties pane

Newsletters - Variable images
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6.5 Print the newsletter

You may want to verify the output before publishing the document to PrintShop Web. Select Print in the File
menu to output the document to a printer.

The newsletter output
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6.6 Publish to PrintShop Mail Web

Choose Publish to Web from the File menu, the Publish to Web dialog appears. Select a Publication type and
click Next.

In the dialog that appears you will need to add the variable images. Select the folder containing the image in
the Browse for Variable Images section and click Add. The names of the images will be added to the Add
variable images section. Click Next to proceed.

Select the Images folder to add the variable images
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6.7 PrintShop Mail Web

Open a browser, for instance Internet Explorer and enter the URL of your PrintShop Mail Web web site. Login,
navigate to the New Document section and select the Newsletter document.

In this case the document requires you to enter data manually (user input) and to upload a database file. First
you'll need to enter information in the user input web form. Click Next and upload the Newsletter.xsl database
file. In the Database mapping page browser through the records and check the update previews. The image
shown in the preview should show the appropriate holiday destination.

The newsletter online

Click Next to complete the ordering process.
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7 Creating a custom Watermark

With the introduction of PrinShop Mail 6.0 you can specifiy objects as non printable. These items will only be
shown in the JPG previews and PDF softproofs of PrintShop Mail Web. Non printable objects can be used to
create custom watermarks and emulate preprinted paper or specific paper types.
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7.1 Non Printable Objects

Placing a watermark on your documents will discourage people from copying them, claiming them as their
own. In PrintShop Mail you can set the non printable property to any kind of object. Here's a simple way to
add a custom watermark to your documents:

1. Launch PrintShop Mail and open the Newsletter.psmd file located in the Newsletter folder (Examples
folder).

2. Select the Image File option in the Insert menu. The Select Image File dialog appears.
3. Navigate to the Newsletter folder located in the Examples folder. Select the watermark.bmp image and

click Open. The image will be placed in the layout.
4. Move the image to a central position on the layout, rotate the image and scale it so it overlaps some

important/variable areas of the design.

The scaled and rotated watermark image in the layout

5. Make sure that the image is selected and select Preview only in the Printing options section of the
Properties panel. By setting this option to Preview only, the image will only be visible in the JPG preview
and PDF softproofs generated by PrintShop Mail Web. Print and PDF output created by an operator (in-
plant status) will not show this object.

The preview only option in the Printing section of the Properties pane

6. To finalize the design you can change the color scheme of the watermark image. As the watermark
image is a black and white bitmap image you can change the colors of its background and foreground
(the black parts).
Select the image and set the Convert to Two Colors option to Yes in the Two color section of the
Properties pane.
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The Convert to Two Colors option set to Yes

7. Now set the Background Color to Transparant and change the Foreground Color to one of the available
colors. This will apply the selected color to the black pixels of the image.

The image converted to a Two Color image

Now you're all set and ready to publish the document to PrintShop Mail Web.

Creating a custom Watermark - Non Printable Objects

Objectif Lune Inc. © 2010 38



8 How to Continue

Now you completed this guide you might want to learn more about PrintShop Mail and/or PrintShop Mail Web.

To serve the world wide variable data needs, we work with a global network of partners, local distributors and
support departments. Check the following website for more information:

• www.objectiflune.com
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